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Test Series Microsoft Word

Module 9 - Adding and Editing Shapes in MS Word

(o] :3Y I Definition

The Insert Menu in MS Word is a feature that allows users to add various
elements such as tables, images, charts, text boxes, and other objects into a
document. This menu helps enhance the document's structure, readability, and

visual appeal.
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Use of Shapes in MS Word

We use Shapes in MS Word to make documents
more visually appealing, organized, and easy
to understand. Here are some key reasons
why shapes are used:

To Enhance Presentation

¢ Shapes like arrows, boxes, and circles can

¢ highlight important points in a document.

¢ Used for decorative elements to improve

e document design.

To Create Diagrams & Flowcharts

¢ Shapes help in creating organizational charts,
e process diagrams, and workflows.

e Useful for business documents, educational
e materials, and technical reports.
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Add Text in a Shape

MBA

Entrance

ol Blunkmg & Step-by-Step Guide:
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Insert a Shape: ' ’
_ e Open MS Word and go to the Insert tab. ﬂ"' o
e Click on Shapes (in the Illustrations group).
(LN o Choose a shape and draw it inyour document.
Add Text to the Shape: ¥ o
I:I e Right-click on the shape. a & oy
e Select Add Text (or Edit Text). £ PacteOions
m IR M © A cursor will appear inside the shape. et
SR Type Your Text: =
e Start typing, and the text will appear inside the = e
riler }
44 LAw Set AutoShape Defaults
s Eﬂtl’ﬂnce & Eomat AutoShape/Picture
¥ New Comment
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: Rotate a Shape in MS Word
Test Series You can rotate a shape in MS Word using the > &
following methods:
Method 1: Using the Rotate Handle (Quick
Method)
Insert a Shape:
¢ Go to the Insert tab — Click Shapes — ! ¢
Select and draw a shape.
Rotate the Shape:
o Click on the shape to select it.
« A circular arrow ([)) appears at the top of
the shape. 3 o
« Click and drag this handle left or right to
rotate the shape freely.

CBSE
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Helping Tool of Shapes

The Format Menu in MS Word provides tools to customize the appearance of text,
images, shapes, and other elements in a document. It helps improve readability,
TR design, and overall presentation.
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Edit Shape in MS Word
The "Edit Shape” feature in MS Word allows users to | |£% Edit Shape "i —
m State _G'"t- modify an existing shape by changing its form, i
LA adjusting its points, or converting it into another I Chaggeﬂh;pe __________ " B
shape. This is useful for customizing diagrams, D
flowcharts, and creative designs. | £< | EditPoints
I'! tl.l'.l Reroute Connectors
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s T 19 Reroute Connectors

A connector is a line that links two shapes. Unlike a normal line, a connector
stays attached to the shapes even if you move them.

Reroute Connectors automatically change the connector’s path to avoid
overlaps or create the shortest path between shapes.

Entrance

This is especially useful in flowcharts, diagrams, and organizational charts where
connectors need to avoid overlapping or tangled paths.

Il

Railways & Metro
ST How to Use Reroute Connectors
1. Insert Shapes
«.Mmany moreg 1. Go to Insert — Shapes.
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. 2. Select a shape (e.g., Rectangle, Oval).
Test Series 3. Draw two or more shapes on your slide/document.

2. Add Text to Shapes

1. Right-click a shape.

2. Choose Add Text.

3. Type your desired label (e.g., "Start” and "End").

3. Connect Shapes
1. Go to Insert — Shapes and select a Connector (like Elbow Connector or
Straight Connector).

2. Hover over the first shape until you see connection points (small dots).

3. Click a connection point on the first shape, then drag to a connection point
on the second shape.

|

Reroute Connector
4. Reroute the Connector

« If you move the shapes, the
connector may twist awkwardly.

: e To fix it:

— BI:;'k""g LB 1. Select the connector line. —
LU 2. Right-click and choose Reroute

| JSompecter

3. The connector will automatically
adjust to take a cleaner or shorter
path.

Central 'Govt.
ervice

I

NOTE: This is especially useful in flowcharts and diagrams-to keep them neat.

i State Govt.

Services

I:I < abc | abe ‘ ‘ Abe | abe
b Enl'tf:x,ce shape Styles in MS Word _ . oo D
Shape Styles in MS Word are predefined formatting
; : an 280
options that allow users to customize the appearance _ PR
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I:I Shape Fill in MS Word lets you add color, gradient,
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Reibways & Melvo customization. It offers various options to enhance the ' - an
S Y PP visual appearance of shapes and make them more "
dynamic in your document. I L I
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T i Gradient - Shape Fill

est Series A Gradient in MS Word is a color effect that blends two or more colors smoothly
within a shape. It enhances the visual appeal of shapes, making them more
attractive and professional.

o]: %Y B More Gradient - Shape Fill
"More Gradients" in MS Word
allows you to create custom
gradient fills for shapes, text, or
backgrounds. It offers advanced
options to adjust colors, direction,

Fill Effects ? x

I

i| Texture | Pattern | Picture

Colors

O One colar
_ and transparency for a ) Two colors
personalized gradient effect. ) Preget

Transparency

From: « > 0w =
Z Shading styles Varianis
Tal Bﬂﬂklﬂg& O lorizantal
nsurance () Vertical

-
-

D Diagonal up
(") Diagonal down
OErom corner

Sample:

Central Govt. © From center
Service Rotate fill effect with shape
i State Govt. |
AL Shape Outline £ shapz Outiine - | | | —

Ll DA P

In Microsoft Word, a shape outline refers to the‘border
or the edge of a shape, such as a rectangle, circle, or
any other shape inserted into the document. The
outline helps define the boundaries of the shape and
can be customized in terms of color, thickness, style,
and other visual properties.
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Shape Effects P ——

[ shape Outline -

In Microsoft Word, Shape Effects are special visual =

— Shape Effects *]

enhancements that can be applied to shapes, such as —3 T
text boxes, autoshapes, or drawn objects. These effects | ——
can make your shapes stand out and improve the overall || | sradow
design of your document. T

—l Sloww

o

__l 3-D Rotation
WordArt Styles

WordArt Styles in Microsoft Word are pre-designed text effects that let you

create decorative and visually appealing text.

. ]
These styles include: . . ’E‘ In o\ A & |
e Text Fill - Allows you to fill the text with F N N 1
solid colors, gradients, textures, or pictures. 4
e Text Outline - Adds a border around the text L/ i\ /) F i
with different colors and thicknesses. A /N ~
e Text Effects - Applies effects like shadows,

flections, glows, 3D rotation, and bevels A A\ F ! A
re ’ ’ ’ : A\ LS -2
e Transform - Lets you bend, stretch, or shape |~ ~ &% & W& & &4
the text into different forms (e.g., wavy,
circular).
Text Fill A Text Fill - | ||2 Text Dird

. . . . . Automatic
Text Fill is a formatting feature in Microsoft Word that

allows you to change the color, gradient, texture, or even
use an image inside the text. It is commonly-used in
WordArt to create decorative text.
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. Text Outline
Test Series gﬁ ext Qutline = | [55 Align Te

Text Outline is a feature in Microsoft Word that allows B Automatic
you to add a border or stroke around text. It is commonly | Theme colors
used in WordArt to make text stand out with different HE EEEEER
colors, thicknesses, and styles.
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Standard Colors
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Text Effects
Text effects in MS Word enhance text with visual styles such S i

— Banking &

as shadows, glows, reflections, and 3D effects. These
nsurance

effects help make text stand out and improve its visual Reflection  »
appeal in documents.
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Text Direction in Microsoft Word allows you to‘change the

1l

orientation of text in tables, text boxes, and shapes. You | Align Text
4o LA can rotate the text vertically, horizontally, or at an angle.
= Entrance ——
. 3 Top
MBA Text Alignment in Microsoft Word allows you to position
LLLLCEIN text horizontally and vertically within a document, table, s—— N Jliddie
I:I text box, or shape. 4
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Create Link

You can add a hyperlink to text inside a text Text in the
_ box in Microsoft Word to link to a website, first shape
email, another document, or a specific section P Flow of text
o CBSE within the same document.
< \/
I:I Linking Shapes with Flowing Text in Word Second
shape

Step 1 - Insert the First Shape

1. Go to Insert — Shapes.

2. Pick a shape (e.g., Rectangle, Rounded
Rectangle, or any closed shape). Third
3. Draw the shape on your page. shape
4. Right-click — Add Text (or just start

typing).

Step 2 - Insert the Second and Third Shapes
—_ Banking & 1. Repeat the same steps to insert two more shapes anywhere in the document.
B PP 2. Add placeholder text if you like, or leave them empty for now.

Step 3 - Link the Shapes Together

1. Click inside the first shape to select it.

LN 2. On the Shape Format tab (appears when the shape is selected), find the
sl Create Link button in the Text group.

o In some versions of Word, you may need to go to Drawing Tools — Format to
see it.

m TPl N 3. Click Create Link — the cursor changes to a pitcher icon.

T 4. Click inside the second shape.

5. Repeat the process:

o Select the second shape.

o Click Create Link.

_ LAW o Click inside the third shape.
- Entrance

L'l

)

-

How It Works

« If the first shape’s text overflows, the extra text flows automatically into the
MBA second shape, then into the third.

L * Resize or move shapes freely — the links still work.

» Change colors and outlines via Shape Format — Shape Fill / Outline.
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: Position
Test Series In Microsoft Word, you can control the position of text,

text boxes, images, and other objects to create a well- EINIE:

[y Bring Forward

Di
o
7

organized document layout.

& Send Backward

Position| Wrap
- Text ~ %Selection Pane|
|| In Line with Text

sl

With Text Wrapping

=l L=l =l
{-y ICSE
] 25 & =4
(=l L=l B
EI More Layout Options...
 JwrapText
: Wrap Text in Microsoft Word controls how text flows —
— Banking & ; ) . —

1 W lriirancs around images, text boxes, tables, and other objects. This = 2 ]
feature helps position objects more flexibly within a Wrap | Bring Send S
document Text = |Forward ~ Backward ~

_ : & InLineith Text
A Squiare
Central Govt.
I l—lght
#E Through
I:I A Topand Bettem
= Behind Text
m Stute GOVt. = InFront of Text
Services ~]  Edit Wrap Points
v  Mowve with Text

Fix Pesition en Page
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Maore Layout Options..

Set as Default Layout

Bring Forward

The "Bring Forward" option in Microsoft Word is used
to move objects (such as images, text boxes, shapes,
or WordArt) to the front of the document layout,
placing them above other elements.

L}] Bring Forward '] |= Align 'I

MBA
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i]] Bring Forward

{3, Bing to Front
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Send Backward

The "Send Backward" option in Microsoft Word is used to
move objects (such as images, text boxes, shapes, or
WordArt) behind other elements in a document. This
helps organize overlapping objects.

Send Backward| =

L:: Send Backward
2y sendto Back
=h sendBehind Text

Selection Pane e v —
The Selection Pane in MS Word allows you to view, e =
select, and organize objects such as shapes, text

boxes, and images in your document. It provides a

simple way to hide, show, or reorder objects for

better document management.

Group in MS Word

The Group feature in Microsoft Word allows you to
combine multiple objects (such as images, text
boxes, shapes, or WordArt) into a single unit. This
makes it easier to move, resize, or format them.

Rotate in MS Word e |
In MS Word, the "Rotate” feature lets you turn

shapes or objects to any angle, either manually or by [y p i, ens 4037 -
using preset options like 90-degree rotations. This N o
helps adjust the orientation of shapes to fit your b Rotate Right 90

document'’s design. A Rotate Left 907
= Flip Vertical

Align in MS Word p

Flip Horizontal

In MS Word, the "Align" feature allows you to position
shapes relative to each other or the page, ensuring
they are evenly spaced and organized.

H More Rotation Options...

Height and Width

In Microsoft Word, you can adjust the height and width of images, text boxes,
shapes, tables, and other objects to ensure they fit properly in your document.
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